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User manual 

Not all things are sharp, but without sharpness, all is nothing. Re-

sharpening is the last and most important step to every image editing 

process, since it will immediately catch the observer‘s eye whether 

something is sharp or blurry. This affects the overall impression of the 

image significantly. With SHARPEN 4 professional, the art of sharpen-

ing will be shaped into an extraordinary experience! The revised soft-

ware with its unique features guarantees razor-sharp photos – re-

gardless of whether the photo looks okay to you, the focus point is not 

in the correct spot or the picture was taken by a jittery hand. 

If blur is not utilised as a stylistic device, you will profit from the soft-

ware’s combination of newly developed presets and algorithms that 

finetunes the image sharpening specially to your motifs. For instance, 

the software is capable of sharpening the eyes of a portrait differently 

than the skin. A blur is analysed and converted differently than a 

macro shot. All these features create unique results. 

Another forte provided by SHARPEN 4 professional is the freedom of 

choice: the automatic system suggests brilliantly sharp images in op-

timal quality, or you use the various finely-adjusted sharpening op-

tions to create an image that is optimised to your own liking and ex-

pectation. But that’s not all: integrated are RAW and grain modules, 

selective drawing that lets you retouch or create composings, and 

scratch and sensor correction. All these features provide you with the 

all-in-one solution for post-processing your images individually! 
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1. Activation 

Activation using Windows  

Upon starting SHARPEN 4 professional for the first time, you will be 

prompted to activate the program. Proceed as follows:  

Install SHARPEN 4 professional as described by the installation in-

structions.    

Put in your serial number. For the box version, this can be found on 

the accompanying booklet. If you chose to download the program, 

you will find the serial number in your customer account. 

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated! 

Note: SHARPEN 4 professional can be installed on up to two com-

puters using the same serial number.   

A second serial number is not required. When installing the program 

on a second device, simply enter the serial number again and click 

“Activate”.   
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2. New Features  

SHARPEN 4 professional offers many new features. Here is a sum-

mary of some of the most important additions: 

 

✓ New procedure “multidirectional sharpening“ with 4 lev-

els for the removal of blur in different directions within an 

image  

✓ Additional Oversampling-levels: 5-fold 

✓ Additional area protection masks: 9 colours, 18 gradients. 

✓ 7 additional presets 

✓ New colour module for selective processing of up to 10 

freely selectable color planes 

✓ Extension of RAW module:  

- Presets in all categories 

- Area protection with 43 different variants  

- New area: “Photo Data“ 

✓ New virtual detail module for the generation of motif-de-

pendent virtual micro details 

✓ New Focus-peaking module for displaying the focused ar-

eas  

✓ Selective drawing:  

-  Composing with 4 additional (now 8) layers 

- New gradient area for adding gradients to existing masks 

- Intelligent Mode for drawing effects 

- New function for creating a mask with details 

- 7 additional methods for offsetting layers  

✓ Granulation module: additional colour spaces HSV/HSL 
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New RAW formats (now1213 supported cameras/formats): 

➢ Canon CR3 

➢ Canon: PowerShot G5 X Mark II, G7 X Mark III, SX70 HS, EOS R, EOS 

RP, EOS 90D, EOS 250D, EOS M6 Mark II, EOS M50, EOS M200, EOS 

1DX Mark III (lossless) 

➢ Casio EX-ZR4100/5100 

➢ DJI:  Mavic Air, Air2, Osmo ActionEyedeas E1 

➢ FujiFilm compressed/16bit 

➢ Fujifilm:  GFX 100, X-A7, X-Pro3, X100V, X-T4 (uncompressed/lossless 

compressed), X-T200 

➢ GoPro: Fusion, HERO5, HERO6, HERO7, HERO8 

➢ Hasselblad:  L1D-20c, X1D II 50C 

➢ Huawei P9 (EVA-L09/AL00), Honor6a, Honor9, Mate10 (BLA-L29) 

➢ Kodak PIXPRO, AZ901 

➢ Leica:  D-LUX7, Q-P, Q2, V-LUX5, C-Lux / CAM-DC25, SL2, M10 Mono-

chrom 

➢ Nikon:  D780, Z50, P950 

➢ Olympus:  TG-6, E-M5 Mark III, E-PL10, E-M1 Mark III, 

➢ Panasonic 14 bit  

➢ Panasonic:  DC-FZ1000 II, DC-G90, DC-S1, DC-S1R, DC-S1H, DC-TZ95 

➢ PhaseOne: IQ4 150MP 

➢ Ricoh: GR III 

➢ Sony:  A7R IV, A9 II, ILCE-6100, ILCE-6600, RX0 II, RX100 VII 

➢ Zenit: M 

➢ Yi M1 

➢ YUNEEC CGO3, CGO3P 

➢ Xiaoyi YIAC3 (YI 4k) 
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3. Configuring the User Interface 

Optional font size for menus and titles 

In the main menu of the program, View → Font size, you will find an 

option to customise the size of the letters in the menu as well as in 

the titles of the programm. 

 

The font size can be adjusted to the run time of the program.  

4K – monitors gives you the option to enlarge the font size for better 

readability of the menu. 

 

Select a font 

SHARPEN 4 professional offers you the opportunity to choose a suit-

able font of your preference. You will find a selection of the installed 

and compatible fonts in View → Font. Simply pick your favourite. 
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If you want to change the font back to standard, select View → Font 

→ Reset font. 
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4. Perfect Picture in No Time  

You can obtain a finished image in just 5 clicks with SHARPEN 4 pro-

fessional: 

 

1. Load Images  

2. HDR Preparation 

3. Post-Processing  → Preset Selection 

4. Click on "Set automatically" 

5. Select Image Segment and Save. That´s it! 

 

 

You can simply drag and drop your images or bracketing series onto the start 

screen. 

This way you can reach your goal in no time, but you can also choose 

the creative way with individual image adjustments or selective draw-

ing: SHARPEN 4 professional offers both variants. 
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At the top of the screen are the main menu and the menu bar. The 

menu bar contains the following functions (from left to right): 

 

 

o Image data browser     

 

o History viewer      

 

o Upload image      

 

o Open project      

 

o Batch processing      

 

 

Optionally, image data can also simply be „dropped“ onto the screen 

by Drag & Drop. The image data is then uploaded automatically. 

 

➢ Image data browser 

For a better overview of your bracketing series, you can use 

the exposure bracketing browser before uploading your 

bracketing series. 

Click on the corresponding symbol in the task bar. A preview 

window will open. Choose your exposure bracketing browser 

folder with „quell folder”. 
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SHARPEN 4 professional immediately starts with the calculation, 

matching the right images automatically as well as showing a preview 

image. If you hover over the image with your cursor, the image will be 

zoomed in automatically. 
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The file type filter is practical since one often has Jpg rows as well as 

RAW images in one folder. But if you type in RAW in the file type, only 

the RAW rows will be shown. Image doubling will be eliminated. 

The search for images is finished at 100%. 

Now you will be able to upload the desired bracketing series. Click on 

the row with a right mouse click and choose in the context menu 

“open as project”. 

 

SHARPEN 4 professional uploads the images of the desired row. Just 

like the simple Drag &Drop of the images on the desktop, now we’re 

starting with the post-processing procedure. 

 



SHARPEN 4 professional – User manual 

13 

5. The Work Area 

As soon as an image file is uploaded into the program, the work area 
opens. 

 

 
 

This area is divided into four main sections: 

 

A) Menu and toolbar (top) 

B) Presets: image suggestions for the photo (left) 

C) Image area (centre) 

D) Denoising and export mode (right) 

 

The areas A), B) und D) can be taken out of the interface and attached 

to a different area or dropped into a different display. 
 
In area A) simply click on the dotted line on the very left of the bar, then 
hold down the mouse button to pull. 
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The areas B) und D) can be moved away by left-clicking on the left or 

right hand side of the control panel and holding the button.  

 

 
 

To reset the work area to its default state, choose View and then Re-

set window. 
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6. Menu Bar 

6.1 File 

File → Home page  

When you are finished with 

the editing of an image or 

you want to close the current 

image, simply click on Start 

(or Ctrl + N). 

 

File → Open Image  

To open an image, click on 

open image (or Ctrl + Shift 

+ O). There you can find the 

edited images.  

 

File → Image Data Browser  

Here you can see all the images in a folder. With one click on the button In-

clude all subdirectories, you activate the recursive search for the image data 

in the specified source folder. 

 

File → History Viewer  

Click here to get an overview of your projects. If you want to open an image, 

just double click on it. 

 

File → Save Resulting Image  

When you are happy with the image and you want to save it, simply click on 

save resulting image (or Ctrl + S). 

 

 

File → Open Resulting Image in External Program  
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If you want to edit the current image in a different image editing program, you 

will not have to leave SHARPEN 4 professional. Simply click on Open result-

ing image in an external program. 

 

File → Create Exposure Bracketing  

If you want to choose differently exposed photos, e.g. to create an HDR image, 

you can easily create a bracketing series with SHARPEN 4 professional. You 

can choose between two modes: "Gamma Correction" (normal) and "Exposure 

Value" (EV value). 

 

File → Print Resulting Image  

Click on this icon if you want to print the current image. The image will be au-

tomatically centred, and the print medium will be scaled. 

 

File → Copy Resulting Image to the Clipboard  

The current image will be copied into the clipboard. You can add the image to 

other programs as well. 

 

File → Projects  

If you have already started a project SHARPEN 4 professional and you want 

to continue to work on the project, open this file by clicking on Projects… 

 

File → End  

Click on End (or Ctrl + F4) to close SHARPEN 4 professional. 
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6.2 Edit 

 
 

Edit → RAW Processing  

If you want to edit a photo without any complications, click on RAW develop-

ment, e.g. to change colours or distort the image (see 18. RAW processing). 

 

Edit → Post-Processing  

As soon as you have developed an image in RAW or removed the noise, you 

will find yourself in the post-processing mode. 

 

6.3 View 

 

View → EXIF Information Window  

Shows you (if available) all EXIF information of an image file, e.g. place, camera 

type, exposure time and time. 

 

View → Histogram  

The histogram shows you the summarised Information of exposure distri-

bution in a photograph. This way you can quickly identify whether a photo is 

over- or underexposed. 

 

View → Full Screen View On/Off  

In case you find the task bar distracting, simply click on Full screen view 

on/off to switch to full screen. 
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View → Interface Style… (dark grey)  

You can change the colour scheme of SHARPEN 4 professional by clicking on 

Interface style. The currently used colour scheme will be displayed in brack-

ets. 

View → Font  

Choose your individual font from all compatible and loaded fonts. SHARPEN 4 

professional now displays the entire interface in the font you have selected. 

View → Font Size  

You can change the size of the font to small, standard and large. 

View → Frame Colour: Grey Card → automatic  

When you click on Frame colour: Grey card → Automatic, the program will 

take the average frame colour of your image and uses it as your frame. 

View → Restore Window Defaults  

Resets the current window to default size. 
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6.4 Extras 

 

Extras → Batch Processing (Ctrl + B)  

The batch processing of SHARPEN 4 professional provides the automatic pro-

cessing of multiple images. 

Extras → Preparing Image  

Here you can determine in which folder projects, exposure bracketing/ photo 

series, final images and default settings will be saved. 

Extras → Benchmark  

If you would like to test how quickly your PC can remove noise from your im-

ages, Benchmark is the function to choose. The programs will render five dif-

ferent images in real-time and provides you with an evaluation on a five-star 

scale.  

Here the text size can be scaled in 4 sizes. 

Extras → Settings (Ctrl + P)  

Here you will find the various configuration options adaptable to your unique 

preferences offered in SHARPEN 4 professional. 

 

 

Program: Program Location 
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Here you can determine to which folder to save your projects, exposure brack-

eting/ photo series, final images and default settings. 

Program: Language 

Here you can change the SHARPEN 4 professional program language to either 

German, English or French 

Program: Accelerate GPU 

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text to explain the function or tool. This is called 

Tooltip. Tooltips can also be deactivated. 

Program: Progress Bar 

During effects in SHARPEN 4 professional, processing will be displayed with 

the help of a progress bar. Here you can decide whether and when to display 

the progress bar. 
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Program: Projects 

When selecting the compression level, you decide how much storage space will 

be allocated for each one of your projects. Simultaneously, you also decide on 

how quickly the saving is performed. A lower level enables you to save projects 

faster whereas a higher level reduces the amount of storage space available 

on your hard disc and, thus, the saving speed is slower. 

Program: Undo 

With the option Save undo steps in projects, you can save all undo steps 

within the project file. The undo-steps will then be reproduced when the file is 

opened. This creates a significantly larger project file. Set the maximum num-

ber of undo steps (1, 5, 10, 20 or 50). If you do not wish to set a maximum, 

select Unlimited.  

The minimum free disc space specifies the amount of free space on your 

hard drive that will not be taken up by saving undo steps. This ensures that 
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your operating software will be functioning properly. By default, this is set to 

10% of your hard disc capacity but can be increased or decreased accordingly. 

Export 

External Programme 

Here you can choose in which format SHARPEN 4 professional will export im-

ages to external programs. Additionally, you can specify which programs 

should be used for external image editing. 

Navigate to the file where the function is installed and select it. 

NEW: You can now store up to twelve external programs and edit their names. 

 

 

 

Save Formats 
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Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and 

image editing programs. Here you can control the quality as well as optimally 

compress the image. Compressed images with high quality look better but re-

quire more storage space. 

Tif 

Here you can choose between different compression methods for your Tif files. 

Png 

Png is popular for its graphics and digital visualisation. Here you can choose 

between various compression methods. 

Automatic 

Automatic: Sharpness Settings 

Here you can activate or deactivate the automatic reset of the quality settings 

for sharpening, such as HD colour protection, a Pro mode and the Sharpness 

Colour Dominance. You can also set Auto Reset to protect image areas when 

loading a new image. If you want to use image area protection in batch pro-

cessing, disable this setting. 

Automatic: Post-Processing 

Post-processing automatically sets the corn engine back to its original settings 

with every newly started project. To use a fixed corn value in batch processing, 

set this the program and then deactivate this option. 

Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or additional 

information. 
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Automatic: Automatic Undo Points 

Depending on the setting of the check mark, an undo point is automatically set 

before RAW development, sensor error correction, selective drawing or the col-

our module. This allows you to access the uploaded original image at any time. 

Automatic: Image Preparation 

Displays the image preparation window when images are exported via plug-in. 

Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed im-

age will automatically be saved in full resolution, even if the preview mode is 

active. Activate the option “show crop window when saving” and the crop win-

dow will automatically be displayed before image saving. 

Automatic: Batch Processing / Image Data browse 
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Here you can activate the automatic loading with the last used directory when 

opening the image data browser. You also activate the automatic inclusion of 

subdirectories in the image data browser and batch processing.  

You can also prevent files from being overwritten by automatically adding the 

original file extension (e.g. jpg, tif…) for the file name created in batch pro-

cessing. 

Extras → Reset  

This returns the current user interface to its original size. 

Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing 

without initiating a file-save, simply select the option Create restore point or 

(Shift + Z). This allows you to return to the last saved state of your image at 

any time. 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 

 

6.5 Add-ons 

Add-ons → Import Add-on  

With the help of Add-ons, you can now not 

only import Presets into SHARPEN 4 profes-

sional but also integrate new post-processing 

Modules that gives your presets with an en-

tirely new look. 

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

Add-ons → Addon Information  

Here you are provided with a display of all information regarding currently 

active add-ons 
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6.6 Information 

 

Information → SHARPEN projects – Homepage  

Click here to navigate to the in SHARPEN 4 professional homepage.  

Information → Show Shortcuts…  

Here you will find all keyboard shortcuts available in SHARPEN 4 professional. 

Information → Supported RAW Formats …  

A list of all cameras whose RAW Files are able to be opened in in SHARPEN 4 

professional. 

Information → Check for Updates …     

This checks online whether newer versions of the software are available for 

download. 

Information → About SHARPEN projects (Shift + F1)  

Information about the current version, third party software and credits from 

SHARPEN 4 professional. 
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7. Tool Bar 

This area of the tool bar divides itself into two separate areas. The left tool bar 

shows the different control functions of the program while the right shows the 

image view functions. 

 

 
 

The functions (from left to right) of this toolbar are: 

 

 Startpage 

 

 History viewer 

 

 Save project 

 

 RAW processing 

 

 Post-processing 

 

 Save final image 

 

 Print final image 

 

 Transfers the current image to the selected application of the 

product family 

 

 Open final image in external program 

 

 Create exposure bracketing 

 

 Create restore point 

 

 Timeline 

 

    Compare View 

 

 Histogram 
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The functions of this toolbar (from left to right) are: 

 

 Real-time calculation mode 

 

When activated, all of the changes that you have made to the preset 

settings will be immediately applied to the image. If this option is de-

activated, then you will only see the outcome of your adjustments 

when you click the button “calculate afresh”:  

 

 Recalculate image 

 

 High-quality display 

 

Activate this option to see the preview image in high-resolution. If the 

preview is set at 100%, there will be no difference. If you zoom in on a 

section of the photo however, there is a noticeable difference in qual-

ity.    

 

 Border pixel display 

 

The border pixel display helps to find image areas that tend to the 

maximum values in highlights and shadows, i.e. white or black. Dark 

border pixels are depicted by blue/purple and light pixels by orange/ 

yellow.  
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Depiction of border pixels in orange and purple tones.   

If you want to brighten this image, you have to be careful with the 

orange border pixels: Light surfaces should not become too white, in 

order to avoid losing detail. In technical terms, these patches are 

called “burned highlights”. The border pixel view helps to find these 

critical image areas. 

 

 Original resolution view 

 

 Zoom to monitor size 

 

 Additional functions:  

 

 Crop image data 

 

 Horizontal mirroring of the images 

 

 Vertical mirroring of the images 

 

 Rotate the image 90 degrees anti-clockwise 

 

 Rotate the image 90 degrees clockwise 
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8. Image Preparation 

Here you can precisely configure the program’s settings.  

 

For the first steps, please use the standard settings. These default 

settings can be restored with the arrow at the bottom left. Nothing 

can be irretrievably adjusted. 
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A) Scaling: When bracketed series are uploaded, the images 

can be scaled from 10% up to 900% using any one of 6 differ-

ent available Scaling Processes. 

B) Colour space conversion: Advanced users can choose a col-

our space here – for all other users, it is recommended to not 

make any adjustments in order to avoid incorrect colour ren-

dering later. SHARPEN 4 

professional offers sev-

eral new colour spaces 

(D65). The standard illu-

minant D65 is representa-

tive for a phase of natural 

daylight with the colour 

temperature of 6500° Kel-

vin.  

C) White balance corrects colour casts that occur with shots 

taken in shooting environments such as warmly lit rooms. To 

start, leave this setting unchanged.    

D) With this regulator one can adjust the colour temperature 

when you are already uploading. It is advised that you leave 

the setting on “default” and to regulate the colour tempera-

ture later in post-processing. 
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E) Optimisations: During loading the Adjustment: RAW to 

camera display converts the RAW picture so that it’s almost 

the same as the camera preview as well as the file preview. 

The automatic brilliance optimisation for RAW files can be 

activated in image preparation under RAW options. A fre-

quent problem with camera RAW formats is that the image 

data will not use all tonal values that are available. The auto-

matic brilliance optimisation compensates this with the up-

loaded RAW images by amplifying the tonal values so that a 

meaningful utilised histogram is created for every camera 

RAW image. 
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9. Post-Processing 

As in the previous version, we start post-processing directly after load-

ing the images. Here we select a preset on the left side and edit the 

result with the functions on the right side of the user interface. 

9.1 Presets 

 

Left side of the post-processing 

screen:  

Here you can choose between 33 differ-

ent presets.   

You can use the opacity slider to reduce 

or increase the effect of the presets as 

needed. The original preset does not 

change, of course. 

At the beginning the preset original is 

selected. By clicking on the thumbnails, 

the effects are calculated in real time and 

displayed in the centre of the screen. 
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If you change the global opacity of a preset, an information box ap-

pears – once per program start – telling you to set the value back to 

100% before loading the next image, since the correction will be ap-

plied, too. When the program is restarted, all values are set to 100% 

again.  

 
 

 

 

 

 

 

 

 

 

Image with „Optimize RAW“ preset 

 

All 33 SHARPEN 4 professional presets at a single glance You can de-

tach the bar “default settings” easily and adjust to the desired size. 
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9.2 Magnifying Glass and Comparison View 

 

On the right-hand side (at the very top) in post-processing you will find 

the 1:1 magnifying glass. The magnifying glass shows you the area in-

dicated by your cursor in a 1:1 pixel view. 

 

Click into the image area of the magnifying glass to change between 

the display modus “divided before/after comparison” and “direct be-

fore/after comparison”. 

To unlock the locked area, press the L button again... 
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By clicking on Comparison view, the new compare window will ap-

pear. This compares your edited image and the original image and 

simultaneously gives you the opportunity to examine the comparison 

through the magnifier display. 
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By clicking on the magnifying glass symbol, you can select a magnifi-

cation between 200% and 1000% and change a selected value with the 

cursor keys while the magnifying glass is active. 

To keep the magnifying glass on a specific point, press down on the 

“L“ key, while you move the cursor over the screen. 

.           

Click into the image area of the magnifying glass, to change between 

the display modus “divided before/after comparison” and “direct be-

fore/after comparison”. 

To unlock the locked area, press the L button again. 

 

9.3 Point of Interest 

Activated “Point of Interest” renders current edits only to a specially 

defined area of the image. The effects will be applied in their full form, 

however only visible in the specified spots, the rest of the image will 

be left unaffected. This effect is intended for very large, high-resolu-

tion photos, e.g. panorama pictures.    
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9.4 Adjust Sharpness 

The image sharpness area on 

the right side of the screen is di-

vided into the following catego-

ries:  
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➢ All Presets  

Select the All Presets category to display all of the available presets 

in the below drop-down menu, and to select a fitting option. Click Set 

automatically to automatically select the optimal preset. 

 

Before and after comparison following automatic processing with the “All 

Presets” category 

 

➢ Blurring  

Select this category if your original image is blurry. The drop down list 

contains a variety of sub-categories to specifically adjust the shake 

corrector. Click Set auto-

matically to automati-

cally select the optimal 

shake preset.  
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Before and after comparison following automatic processing with the “Blur-

ring” category. 

 

➢ Haze & Fog  

If haze and fog interfere in your original image this function is the right 

choice. The drop-down list contains a variety of sub-categories to spe-

cifically set the haze or 

fog reduction. Click „Set 

automatically“ to auto-

matically select the opti-

mal haze/fog preset.  

 

 

Before and after comparison following automatic processing with the "Haze 

& Fog" category 

 

➢ General image sharpness   
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If you are not faced with a specific problem like haze & fog or shake, 

you can adjust the general image sharpness by clicking General Image 

Sharpness.  

Use the options found in the drop-

down menu to choose the criteria 

for how, and to what degree of in-

tensity, the image should be 

sharpened. Click Set automati-

cally to automatically select the optimal overall sharpness preset. 

 

Before and after comparison following automatic processing with the "Gen-

eral Image Sharpness" category 

 

➢ Portrait   

If you are working with a portrait that needs a bit of sharpening, select 

this category. Further sharpness presets can be found in the drop-

down menu. Here you can 

choose the sharpness intensity. 

There is a soft look (for blurring 

effects) and a mono-

chrome/black and white ef-

fect. Click Set automatically to 

automatically select the optimal  

portrait preset.  
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Before and after comparison following automatic processing with the "Por-

trait" category 

 

➢ Landscape  

Select this category if your photo is 

a landscape that needs sharpening. 

Select the intensity of the sharpen-

ing in the drop-down menu. Addi-

tionally, there is also a soft look (for 

blurring effects) like in the category 

portrait. Additional effects like an 

HDR look are also available. Click 

Set automatically to automatically select the optimal  landscape pre-

set.  
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Before and after comparison following automatic processing with the "Land-

scape" category 

➢ Artwork    

The “Artwork” category offers vari-

ous sharpness, blur and editing ef-

fects. If your image doesn't fit any 

other category, this is your jackpot! 

Give the different settings in the 

drop-down menu a try. 

 

 

 

 

 

 

Before and after comparison following automatic processing with the "Art-

work" category. 

 

Automatic Processing: 

The Set automatically button automatically modifies the currently 

loaded image.  
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The automatic processing analyses the existing image material and 

looks for suitable presets based on the selected category. 

The photo will be processed immediately, and the automatically ad-

justed result will be instantly displayed. 

 

Automatic sharpness before and after comparison 

It is recommended to begin with the automatic setting or a combina-

tion of blur and shake presets and the automatic, since this often 

leads to the best results. In the automatic setting, the haze and fog 

correction are always activated, which can lead to slight colour distor-

tions, e.g. in portrait shots. Therefore, the second option is the more 

"natural" choice in many cases. 

Then you can adjust the image sharpness and the photographic set-

tings as you wish. 

Sharpness Colour Dominance: 

Some tools, such as Color Dominance and Area Protection, are hid-

den for the sake of clarity and only become visible when, e.g. a slider 

is moved in the Image Enhancements area or a sharpening option 

such as Portrait is selected with subsequent sharpening automation. 
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A special feature of SHARPEN 4 professional is the sharpness colour. 

It is used to specialise the image sharpening processes in a selectable 

colour space. 

 

- The front camera symbol is used to adjust the algorithms 

to the average colour of the motif. 

- With the eye symbol, settings are used which correspond 

most closely to the colour perception of the human eye. 

- The following 8 colourful buttons ensure that the sharp-

ness procedures treat the selected hue with increased 

accuracy and thus produce a finer image sharpness. 

Oversampling: 

Oversampling considers 

all previous sharpness 

settings such as automatic, multi-directional sharpening, area protec-

tion, etc. and converts these calculations into a multiple calculation 

(cascade). Each calculation is performed at a lower intensity, which 

leads to more balanced, nuanced results with finer details and re-

duced sharpness halos.  

For this reason, it makes sense to experiment with the different over-

sampling levels at the end of all sharpening processes in order to save 

or print the highest-quality result image.  

The oversampling level defines the number of calculation steps in 

which image sharpness is calculated. The more steps you select, the 

finer and more precise the generated image sharpness gets.  

Note: The calculation time increases accordingly with the number of 

steps. 
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Protect image areas: 

In the drop-down menu, you can select one 

of numerous different presets to protect 

certain areas of the image when calculating 

sharpness. The presets are divided into 

“skin tones”, “sky blue”, “organic green”, 

“colours”, “grey tones”, “centre”, “edge ar-

eas”, “smooth areas”, “details”, “shadows”, 

“mid-tones” and “lights”. 

Example 1: For example, if a blue sky is 

grained by sharpening the image, simply 

select Protect sky blue to prevent the 

sharpening of the blue sky areas.  

Beispiel 2: Select the area protection Pro-

tect centre. If the image is blurred to-

wards the edges, the image will be sharp-

ened evenly, because the focus in the cen-

ter is protected from re-sharpening. 

Beispiel 3: If you select Protect border ar-

eas, the center is sharpened more and the 

focus is drawn more to the centre of the 

image.  

The selected protection areas cannot be combined with each other. 
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The eye symbol  next to the drop-down menu shows you the 

masking in the image. Light areas are sharpened more than dark 

ones. 
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With the slider Smoothing you can adjust how smooth the masking 

of the image sharpness will be. The symbols below determine the ef-

fect of the masking: 

 

 
Masking only affects the sharpness settings. The 

photographic settings affect the entire image. 

 
Masking affects both the sharpness settings and 

the photographic settings. 

 
Masking only affects the photographic settings. 

Sharpness settings affect the entire image. 

 

Click on the arrow symbol  to reset the mask area. 
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New Module: Multi-directional Sharpness 

 

This new module can bring out even more sharpness than the sharp-

ness categories in combination with the automatics, especially in very 

detailed areas such as the eyes in portrait shots. All photographed im-

ages have blurring, which is distributed around the individual pixels. 

The Multi-directional Sharpness does not determine this blur for the 

entire image in general, but for each individual image element and 

pixel, and corrects and reduces it by up to 90%! This applies equally to 

general blurring, which can happen due to inaccurate focusing, as well 

as to directional blurring, which can occur due to camera shake, for 

example.  

You can choose between 2 options or intensity levels (if the left button 

is activated, Multi-directional Sharpness is switched off): 

Level 1: Activates multi-directional sharpening with a small radius. 

Level 2: Activates multi-directional sharpening with medium radius 

Level 3: Activates multi-directional sharpening with a high radius, 

which means a significantly longer calculation time. 
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Image example 1: Category Portrait/Fine Sharpness, Multi-directional 

Sharpness Level 1, Protect Image Areas/Protect Smooth Areas: The 

eyes and lips are very well sharpened, the skin is only slightly sharp-

ened due to area protection 

Image example 2: Shake & Blur Presets category, Multi-directional 

Sharpness Level 2: All flowers have a pleasant, even sharpness. 
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Reduce blurring:  

You can choose be-

tween four different 

modes. The Balanced 

mode is a compromise 

between calculation 

time and the quality of the blur reduction and therefore offers good 

and fast results. The Pro mode increases the quality and requires 

three to four times more calculation time than the balanced mode. 

The Pro+ mode increases the quality substantially and requires about 

ten times longer in calculation time than the balanced mode. The Pro 

Infinity mode increases the quality of the blur reduction to the max-

imum possible and can require significant calculation time. 

 

Use the correction slider to select the amount of shake correction. 

 
 

Use the second slider to select the radius of the shake. A high value 

corrects large-surface camera shake, but also requires additional cal-

culation time. 

 
 

 

The higher you set the quality the more detailed blurs will be cor-

rected, and the more calculation time will be required. 

 

 
 

The fineness indicates whether the shake correction should focus 

more on the large or the fine areas. The higher you set this value, the 

finer the correction will be and the longer the calculation will take.  
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Camera shake correction increases image noise. The amplified noise 

can be counteracted with this control. 

 
 

HD colour protection:  

If you have objects in your image that are particularly different in col-

our from others, you can activate the HD colour protection and thus 

ensure that the colour and the colour edges are calculated specifically 

and produce a much better result image. 

HD colour protection is an extension of the camera shake correction 

process. Special focus is made to preserve the exact colours of the 

image. This function requires additional calculation time.  

 

Example: 

 

The color detail on the edges of the shield is much more realistic. 
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Blurring comparison view:  

 

With the Point of Spread Function (PSF) comparison view, you can 

compare the distribution of blur of a single pixel in your original image 

and your sharpened result image. The larger the bright area in the left 

image, i.e. "before", the more blur was found in the image. Conversely, 

the smaller the area in the right image, i.e. "after", the better the blur 

correction worked. In the best case an almost single bright pixel 

should be visible in the middle of the display.  
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Visual comparison of the original to the re-sharpened result image...
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... and visualization of the blur distribution in the image.  

On the left-hand side, you can see a distribution around the centre 

point. This means that there is an undirected blur. This could be 

caused by inaccurate focusing. With the slider Brightness/Contours 

you can switch between the brightness mode and the contour mode 

as basis for the calculation of the blur distribution.  

 

The info icon next to it starts the contour analysis of your image and 

sets the brightness mode or the contour mode for the blur reduction 

depending on the result. You can change this setting later if you do 

not like the result of the automatic setting. 
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If you click on Blurring comparison view, a new window opens in 

which you can directly compare the before and after sharpness. In the 

toolbar at the top, you can select different view modes to display the 

sharpness. 

 
Displays the original image on the left and the processed 

image on the right. 

 
Displays the processed image on the left and the original 

image on the right. 

 
Displays the same image section for the original image on 

the left and the processed image on the right respectively. 

 
Displays the same image section for the processed image 

on the left and the original image on the right respec-

tively. 

 

Activates/ deactivates the preview. Click on the preview to 

shift the main view to the clicked section. 

 

Activates/ deactivates zoom view on the mouse cursor. 
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Puts the zoomed view in centered mode. 

 
Puts the zoomed view in non-centered mode. 

 

Photographic settings: 

The photographic settings allow you to make additional image adjust-

ments in the following areas:  

 

• Haze and fog: Reduces 

the haze and fog in an 

image. The further right 

you move the control, 

the higher reduction in 

haze/fog.  

Note: If you are working with 

Jpeg images, artefacts will be 

created that are already con-

tained in the Jpeg file. 

• Brilliance: The motive brilliance strengthens the depth effect 

in an image. 

• Brightness: Change the brightness of an image to fit your 

wishes. 

• Colour: Control the colour strength from a little bit of colour 

(control left) to a lot of colour (control right). 

• Structure: Change the design of the structure in the image. 

To smoothen the structure, move the control to the left, to 

strengthen the structure move the control to the right. 

If you have an image with a lot of mist or fog, these settings can be 

taken over by the automatic in the category haze and fog. 
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In the following image, the meadow is hardly distinguishable from the 

flowers and even the colour is almost completely hidden by the mist. 

After editing with  the photographic settings, the meadow is clearer, 

and the colours are more saturated. 

Note: If you are not satisfied with the automatic setting, you can ad-

just the controls until you are satisfied with the result. 

 

 

Before and after comparison of the automatic haze & fog correction 
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10. New Module: Virtual Micro Details 

 

This module creates virtual micro details.  

Virtual means that details are "calculated in" – depending on the se-

lected category –  which could possibly be in the image but are not 

existing in the original. The individual categories – e.g. "Landscape" 

and "Mountains" – can be combined if required. 
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By clicking on a category or the arrow to the right of User, colour tones 

in the image – e.g. green lawn or blue sky – can be given greater or 

lesser consideration. The same applies to the differentiations in the 

categories.  

 

With the combination of 2 categories (landscape/architecture) and the 

emphasis on the colors gray, yellow, green and blue, the sculpture, 

lawn, gravel ground and sky have become much more alive.  

This allows any somewhat dull image to be individually spiced up with-

out looking unnatural or exaggerated. 
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11. Granulation  

 

Especially with black and white portraits or composings, it often is use-

ful to add a "good" kind of noise. This allows you to achieve a "nobler" 

look with many subjects, or the various individual images in compos-

ings blend better.  

With fractal grain, you can create exciting or dramatic image moods, 

among other things.  

New in the Grain module are the two colour spaces HSV and HSL. 

a) Natural grain 

In Natural grain, the different 

levels of photographic paper 

are simulated, which creates a 

natural irregularity.  

These following parameters are 

therefore at your disposal: 

- Form  

Choose here from six different 

variants. 
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- ISO-Number 

The preset value conforms to the average „restless value“ on a natu-

rally grey surface. 

 

- Size 

The maximum size of the simulated grain. 

 

- Masking 

Gives you the opportunity to calculate the granulation in all different 

types of daylight or alternatively in light, shade or shade and light. 

 

 

 

 

A click on the button creates a new random distribution of 

grain and therefore a whole new look. 

 

 

 

 

 

b) Fractal grain 
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Fractal grain simulates a large-

scale irregularity, which is cre-

ated through the storing and 

deterioration of photo mate-

rial. For this, you have the fol-

lowing parameters at your disposal: 

- ISO-Number 

The preset value conforms to the average “restless value” of a natu-

rally grey surface. 

- Quality 

Determines the accuracy of the calculation (number of iterations for 

the fractal algorithm) of the fractal granulation. 

In the granulation module there is no singular best setting, since the 

ideal grain size, form and quality is 100% dependant on the motif. 

Here you can try out different things and find new creative paths. 

A click on the button creates a new random distribution of 

grain and gives your image a whole new look. 

12. New Module: Colour Module 

In this module, you can 

edit colours from the 

loaded image itself, for 
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example, re-colouring, enhancing, saturating or desaturating.  

Simply click the green button to select a new colour layer…, 

... in the interface that appears, use the pipette to select a colour that 

you want to change. The black areas in the image are colours such as 
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white clouds (colourless), which cannot be changed. 

The colour selection area is 

displayed in the colour circle.  

 

 

 

 

 

 

 

 

Once you open the settings, you can visualise the selected areas by 

clicking on the eye symbol and selecting any mask colour.  
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You can adjust the colour selection using the handles in the colour 

circle. Dragging the handles to the left or right of the selected colour 

selection expands or narrows the range of colours.  

The graphic shows that expanding green colours would include the 

green trees in the recoloration.  

Pulling inward: Less saturated areas are included.  

Pulling outward: More saturated areas are included. 
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If the selected colour range meets 

your expectations, use the sliders to 

set a new target colour, brightness, 

saturation or other parameters.  

 

You can create up to 10 new colour layers.  

Use the Close button to return to the finalising mode.  
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13. New Module: Focus-Peaking Analysis 

 

The focus-peaking module analyses the final calculated image, i.e. the 

final image after all adjustments have been carried out.  
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… and visualises the “sharp” (more precisely: pixel-wise contrast-rich) 

areas as soon as you click on the Focus-peaking button.  

 

An exceptional feature is that sharpness parameters can be expanded 

or narrowed and the distribution of image sharpness per pixel can be 

visually observed in the sharpness histogram.  
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For instance, in the case of narrowing (slider to the right, in the exam-

ple set to 40), only the very sharp areas are displayed (the blue area 

in the sharpness histogram is very small), thus providing a very pre-

cise overview of the sharpness progression or the amount of sharp-

ness displayed in an image.  

In the image example, the soft, i.e. not quite sharp pixels that depict 

the smoother areas without details are clearly in the majority. By click-

ing on the button on the right, this sharpness mask can also be saved.  

 

14. Local Adjustments and Selective Drawing 

The highlight tool from 

SHARPEN 4 profes-

sional deserves special 

attention.  
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With the 3 masks (from left to right) 

Effects, Colour Filter and Compos-

ing, you can process whole images 

or image sections (Effect masks), 

influence colours in the image (Colour filter masks) or realise creative 

new image ideas in 8 composing masks (previously 4).  

14.1 Effect Masks (FX) 

Firstly, this tool selectively edits 

chosen areas without complicated 

masks done by hand, like other 

photo editing programs. SHARPEN 

4 professional includes a com-

pletely newly developed intelligent 

border recognition algorithm, that 

independently identifies borders, 

lines, differentiations and light dif-

ferences in drawing mode. The boundaries of the area that the cursor 

hovered over are saved as a mask. These easily and precisely set 

masks serve as the basis for eleven important image enhancements: 

„Correct red eye“, „Beauty“, „Shading“, „Illuminating“, “Intensifying Col-

our”, “Reduce Colour”, “Strengthen Details”, “Reduce Details“ and „In-

crease contrast“ etc. 

These masks can even be saved as a separate image file and used in 

other image processing programs. 

How it all works is probably easiest to explain with an example. Open 

the selective drawing window (post-processing, finalise - bottom 

right). Our example is a single RAW file of a mountaineer. The picture’s 

colour details are already well edited. Now we want to make the rock 

a little darker without darkening the rest of the picture.  
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➢ Quickly finalise your image with Selective Drawing 

1. Select editing objective 

For this case, select Shading. Make sure that the selected mask func-

tion is activated, and the green checkmark is showing.  

 

2. Activate drawing mode   

3. Activate filling mode   

4. Run the mouse over the contours without clicking. You can 

decide and correct the brush size af-

terwards.  

New: The brush size has been 

changed to permille, which allows an even finer adjustment 
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and the circle display around the brush is now perfectly cen-

tred. 

5. Now look at the mask display. The object whose borders 

were automatically recognised is now depicted. Click and 

hold, and then trace your mouse along the edges of your cho-

sen object until it is completely selected. Attention! In the 

blink of an eye, we will see the effect as well as the overlying 

mask. 

 

 

6. Once fully selected, blend the mask out by moving the mask 

intensity control to the left.  

 

 

7. You will now see only the effect, that is darker rocks - our ob-

jective was Shading. Now you can adjust the intensity of the 

effect by sliding the control towards the + or - according to 



SHARPEN 4 professional – User manual 

75 

your preferred strength. Done. The rocks are darker while the 

rest of the image remains untouched.  

 

8. Click on Close. You will be returned to post-processing and 

the selective change will be applied. 

 

 

 

 

9. Use your quickly made mask for a further effect. Go back to 

the selective drawing. The selective mask has remained.  

10. Click on  and copy the mask to the clipboard. Switch the 

mask to Sharpen and use the  to paste the mask back 

again. Now you have only sharpened the rocks, and the other 

parts of the image were not influenced. 

On the right you can clearly see the darker rocks after the selective correc-

tion. The rest has the same tonal values as before. 
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11. Every selectively applied effect can be activated and deac-

tivated with the green checkmarks.   

12. Borders have different intensities in every image. Presets 

normally do just fine, but sometimes it is necessary to adjust 

the contour and sharpness settings in order to reach perfect 

fine-tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border 

recognition? You can easily remove it with the eraser .     If 

you only want to remove a small section, use the eraser with 

limitation. When set to 50%, you can only remove 50% of the 

mask, regardless of how much you erase. The limited draw-

ing mode works in the same way, and only draws at a certain 

opacity. 

14. If you want to mask the entire image except for a small ob-

ject, it is a good idea to mask only the small object and then 

reverse the mask by clicking on the . 

 

Pro Tip:  You have two filling modes to choose from when you want 

to fill a mask. When do you use which mask? We used the normal fill 

mode  – like in our example for a large surface – which is also rec-

ommended for water and sky areas. 

Ray filling mode   is very precise and favoured for smaller objects, 

geometric forms or subjects with straight lines, like in our following 

example. 
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With ray filling mode you can mask just the walls of the skyscraper while the 

window surfaces are not selected. 

 

Functions and Possibilities in Selective Drawing 

- Optional Mask Colours 

Select a colour for the presentation of the mask and the brush.  

 

The display will be immediately adjusted to your desired colour. 

 

- Selective Drawing – Creating Masks 

New in SHARPEN 4 professional is a gradient browser. In contrast 

to the gradient selections in the expert mode of other projects 

programs that seem identical at first glance, the mask is created 

directly in the image and the gradient masks can be combined. 

This means that you can, e.g. protect the right and left edges or 



SHARPEN 4 professional – User manual 

78 

other image areas from the previously applied sharpening if you 

have selected Show original image in the effect masks! 

 

 

By clicking the button, 

the window with the pro-

cess selection will open.  
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Here you can choose the gradient(s) that will exclude the desired ar-

eas of the image from sharpening. 

White means: The original image without sharpening will be 100% 

blended in again. 

Black means: The mask has no effect at all. 

The soft transitions provide a smooth sharpness gradient. 

The mask that is displayed visualizes the progression: The previously 

set sharpness parameters are completely removed in the top part of 

the image and then slowly blended in. 

Masks can also be created from a colour, brightness or level of detail. 

 

With the button (1) you activate the Create Mask modus. You will find 

yourself in the standard mode Create Mask out of Colour(2). If you 

want to create the mask from a brightness, choose the (3) button. 
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If you want, you can use the but-

ton (4) to select a contour thick-

ness or details and combine 

them with the gradient mask(s), 

e.g. like in this image.  

If you move the eyedropper over 

the smooth skin areas – like in 

the image – these are excluded 

from the sharpening. If you 

move it over detailed areas such 

as hair, these are protected.  

This allows you to optimise the 

general sharpening of the whole 

image quickly and individually by combining different masks and, if 

necessary, also expand or narrow these masks with the brush! 

The tolerance controller decides, how sharp (smaller value) or soft 

(higher value) the created mask will be. 

While you are in the “create mask” mode your mouse pointer will turn 

into a pipette. The colour or brightness in which your mouse pointer 

is set, will determine the type of mask being created. 
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In the above example we can see how a red mask was created for the 

sky. 

Hint: If you want to combine several colours in one mask, simply click 

on the desired colours one after another with the pipette on the 

screen. The current colour will be added to the current mask with 

every click. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask and consequently soften these.  

 

To soften an area even, just go over the same area with the smoothing 

brush several times. 

 

- Global Mask Functions 

In the area of global mask functions, you can find several special 

modes that you can use directly.  
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1. Reducing the entire mask outline 

becomes    

 

2.  Increasing the entire mask outline 

 becomes   

 

3. Soft-focus effect on the entire mask 

becomes    

 

There are two buttons for each of the global functions. The left button 

always carries out the function with a low effect, while the right button 

has a strong effect. 

 

- Multiple Undo and Redo for Brush Functions 
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Click once or several times on the left arrow to go back one or several 

brush strokes or on the right arrow to jump forward one or several 

brush strokes. 

 

- Reset the Function of a Mask 

Every mask can without any influence on the other masks be reset to 

its original state. Simply click on the trash can button (1). 

 

After clicking on the button, a security query will follow, so that no 

important work will be lost by accident.  

Beauty: 

This is how you smooth the skin of people in three easy steps. 

Step 1:  

In the effect masks area, 

choose the mask Soft skin 

in selective drawing mode. 
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Step 2: Through repeatedly clicking the area, you choose the area to 

be edited. Don’t worry, the yellow colour will disappear later and 

only serves to visualise the process. 

 

 

 

Step 3:  Click on Close to apply the chosen mask on the photo. 
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Correct red eye  

This is how you remove red eyes in three easy steps. 

Step 1: Choose the mask Correct red eyes in selective drawing 

mode. 
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Step 2: Choose the red pupils with the paintbrush. 

 

Step 3:  Click on Close to apply the chosen mask on the photo. 

 

Intelligent Mode for drawing effects 

 

If you select an effect such as Intensify colour in the image example, 

the intelligent mode is activated – from SHARPEN 4 professional on – 

and can be deactivated.  

This mode adjusts the impact of a selected effect to the loaded image.  
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and prevents, e.g. that everything in the image is assigned the same 

intensity when a colour intensification is applied. 

 

By clicking on the mask symbol with deactivated intelligent mode, the 

mask will be inverted. This results in way too colourful and oversatu-

rated colours which can be corrected using the intensity slider. 

 

The activated Intelligent Mode differentiates depending on the motif: 

the effect is less effective in highly saturated areas, and more effective 

in less saturated areas. 
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This mode ensures that for all effects, the original is analysed. The re-

sulting image does not usually require further manual correction. 

14.2 Colour Filters of Selective Drawing 

 

Next to the effect masks, you 

can find the colour filter 

masks. Click on the drop-

down menu to choose one 

of the following filters: red, 

orange, yellow, yellow-

green, green, cyan, blue and 

violet. 

Colour filters work like the colour filters on cameras. They absorb cer-

tain colours, filter them out or let the other colours through. The filter 

module is a tool that lets you enhance or reduce certain colours, make 

them brighter or darker, and correct or even alienate image content.  

 

Original 
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For instance, the red filter absorbs the colour red , strongly darkens 

blue colours like the sky and brightens red/orange tones.

 

The blue filter lightens blue tones, making them appear more radiant, 

and darkens red tones.  
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Adaptation of automatic masks in the Distortion correction sec-

tion of the RAW module 

Selective drawing works together with the RAW module. This includes 

the Distortion correction which is part of the RAW module and is 

automatically applied to all of your drawn masks. 

 

The sky has already been masked in this example. By correcting the 

horizon in the RAW module retrospectively, the drawn mask will auto-

matically adjust itself to the Distortion correction. 
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14.3.  Composing module 

 

Composing module: On the left the uploaded original, on the right the 

preview thumbnail, masks and parameters. 

In the Composing mode of selec-

tive drawing, you can build up to 8 

layers of images into your current 

motif. 

To switch into the composing mo-

dus, click on the Composing but-

ton (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the currently chosen mask.  
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With a click into the chessboard 

pattern (4), you can upload any 

image you wish to create the next 

level with. 

You can use RAW images, Jpg, Tiff 

as well as several other image for-

mats. 

 

 

 

Underneath the display screen 

you will find the parameter area 

that begins with two buttons with 

the following functions: 

(5) Multiple application 

Reduce the size of the image on a 

different level than the one that 

you are currently working on. 

With this option you will be able to 

stretch the reduced image outwards (up, down, left, right). 

(6) Determine the width-to-height ratio 

This function allows you to determine the width-to-height ratio of the 

uploaded levels, since the width-to-height ratio in an uploaded image 

level can differentiate from the current image you are working on. 

This preserves the proportion of the levels. 

 (7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without having 

to make changes to the image layer.  

(8) Vertical Reflection 
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This function allows the image layer to be mirrored vertically. This en-

ables more precise adjustment to the current image without having 

to make changes to the image layer.  

(9) Control parameter 

Width-to-height ratio: If the 

width-to-height ratio is not ad-

justed with the sliders (6), you 

can change the width-to-height 

ratio as you desire. 

Zoom: Choose the size of the 

layer image by zooming in or out 

Moving horizontally: Move the 

layer image to the left or right 

Moving vertically: Move the 

layer image up or down. 

 

Exposure: If the exposure of your current image does not match the 

exposure of any other layer image, you can easily adjust the exposure 

of the layer image here and darken or brighten it as desired. 

NEW: Using the Contrast and Colour sliders, you can further adjust 

your composed image next to the exposure that it blends in even bet-

ter with your original image and the overall image looks even more 

realistic. 
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With drawing mode (brush) activated, you can now paint/blend in the 

new background as desired. 

 

You have now created your first composing. 
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Save the generated mask in a folder of your choice under a descriptive 

name. You can access your saved mask again at any time. 

If you want to add more atmosphere 

to the composing, you could load in 

a dark sky in Composing mask 2,  for 

example.  

Click Invert current mask to invert 

it. The sky covers the whole image 

now.  

Set the calculation mode to Multiply 

and you get the 2nd composing be-

low without any further painting. If 

wanted, you can use the eraser to 

lighten the dark areas a bit. 
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With this module you can realise your image ideas.  

Composing example 2 

 

A night shot with a not very exciting night sky… 
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...quickly transformed into an eyecatcher with the help of the com-

posing module. 
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15. Removal of Scratch and Sensor Errors 

 

Unfortunately, digital photography with its micro-contrast enhance-

ment reveals any unwanted sensor contamination, which every pho-

tographer knows and fears despite in-camera sensor cleaning. Don't 

fret – simply eliminate! With the handy correction function of 

SHARPEN 4 professional, this can even be a lot of fun.  

Pro hint: This intelligent correction does not only remove sensor 

spots, but other annoying things too. For instance, an empty beach 

can be created easily. 

Easily erase image flaws from your shot - the program will automati-

cally replace these areas with suitable elements.

 

The sensor spots are circled in red.
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To make the correction, proceed as follows: 

Select the brush tool under (6) and click on the point of the image that 

you would like to correct. A circle will appear beside it that will serve 

as a source.  

Move this circle to a place on the image 

that can act as a source for the first 

marking. The selected area will then be 

improved based on the source. 

 

Prior to this, you can reveal sensor 

spots, which will appear as a bright 

patch in the image, with (1). 

 

(2) Allows you to expose or hide the 

fixed areas. The corrections are still ac-

tive, even if they have been blended in. 

Hiding is solely to enable a before and 

after comparison.  

 

You can select multiple areas to correct 

by simply clicking on the brush symbol 

(6) and adding another point. The button marked (3) can blend the 

targeted corrections in and out, which also controls clarity.  

 

NEW: The quality function provides you with a drop-down menu in-

cluding five new quality modes allowing you to automatically search 

for corresponding areas. With the different quality levels, you can 

scale how the automatic search proceeds. 
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Note: This search quality is used for all of the following search area 

settings. 

(5) Deletes the added corrections.  

 

The section marked (7) controls the size of the area that is to be cor-

rected.  

 

You also have the option to automatically search for the best source 

area for the improvement. Click on the (8) button.  

 

Button (4) calculates the appropriate correction spots for all of the 

points automatically set using (8).   

All currently selected corrections can be deleted with the (9) button.   
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The sensor spot corrector marks all of the patches and determines a source 

within the image that can be used as a substitute.

 

Successful sensor spot correction. 
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16.  Workflow 

➢ Edit final image further in an external program 

SHARPEN 4 professional offers interaction with external programs. 

This way you can take a successful result to another photo editing pro-

gram and continue there. 

 

➢ Open in other projects programs 

Click on the symbol Transfer 

the current image in the 

toolbar to open the image in a 

different program from our pro-

jects family. Use the drop-down 

menu next to the symbol to 

choose one of the programs that 

you already have installed on your computer.  

 

➢ Open in other image editing programs 

To directly open the image in another photo editing program as Pho-

toshop, click on the Symbol in the symbol bar.  

 

If necessary, go through the settings to 

show the path to the program. Click on 

Extras in the menu and select Set-

tings in the drop-down menu: 
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Next, click on the Export tab. You can enter the name of a photo ed-

iting program here and save it for later as well.  

Except for Adobe, you have the option to rename the external editors. 

The name you assign will be displayed in the Quick Export menu in 

the toolbar of the main screen. 
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➢ Work with a Timeline and Restore Points 

This option can be found in the symbol bar at the top edge of the 

screen: 

 

Create Restore Point saves a virtual snapshot of the current settings. 

You can now always return to this stage of your editing. You can save 

as many editing restore points as you like. The timeline displays the 

restore points and makes it possible to call up any phase of the editing 

process with just a single click:   

 

This function is especially useful when, for example, you are satisfied 

with an image, yet want to continue trying out different settings and 

effects. Simply set a restore point and carry on editing your picture. If 

you want to go back, simply click on your restore point in the timeline. 

If you click on  you can add your own note as a heading. 
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17. Selecting and Saving Sections of Im-

ages   

To save a final image, click on the button in the toolbar, go 

through the file menu or use the corresponding keyboard 

shortcut (Ctrl + S).   

 

➢ Cropping and captions 

As soon as you have initiated a file save, the cropping and caption win-

dow will open. If you would not like to crop or add a caption to your 

image, click continue.  

 

At the top are several practical aids for perfect image composition and 

cropping. 

You can set the aspect ratio and activate guidelines like the rule of 

thirds, the golden section or the golden spiral. The new photo centre 

display is also quite practical which you can access by simply 

clicking on this button. 
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo. 

At the bottom is an option to enter a caption. You can determine the 

size, position and background for the text. 

The size of the text will be automatically coordinated to the final crop-

ping. 

 You can either crop by hand 

or use one of the 71 provided 

formats. 

Please note: If you choose 

the cropping ratio 13 x 18, for 

example, the final image will 

not be saved as 13 x 18 cm, 

rather as a ratio of 13 to 18.    

You will also find the "Scale 

and Save" button at the bot-

tom. With this option you can choose between 30 different templates 

for various online platforms such as Facebook, Instagram, YouTube, 

etc. or simply specify your own scaling values (scaling in percent and 

resolution in pixels). 

 

As soon as the image has 

been cropped and cap-

tioned, confirm the save 

and the following window 

will prompt you to select a 

file format and name your 

file. 
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18. RAW Processing 

You can upload and edit RAW image 

data with the integrated RAW mode. 

Numerous tools are available to you 

here, such as denoising/sharpen, expo-

sure, colour and detail as well as pow-

erful distortion capabilities.   

Changes that are made in this RAW 

mode will be transferred onto the en-

tire bracketing series, so that you only 

need to put in the settings once. 

New in SHARPEN 4 professional: 

- Area: Photo data 

- Area protection with 43 different variants  

- Presets in all categories 

 

Area Photo Data 

 

Here you can see selected settings for the invited image: resolution, 

aperture value, time, focal length and ISO number. 
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Area protection 

 

This area protection is identical to the post-processing module (see 

Chapter 9/Protect image areas) and can be applied differently in each 

selected category if need be.  
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Presets  

 

In all categories, in addition to the individual parameter changes, you 

can now select presets that meet your ideas of a specific image mes-

sage or look.  

Resetting the category: 

By clicking the reset-button (bottom left) every category can be reset 

to its original state without influencing the settings of the other cate-

gories. 
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Overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. Use 

the pipette to select a white balancing colour directly from the image.  

Denoising/ Sharpness: This feature regulates the image’s noise and 

sharpness. Control the quality and different types of noise such as 

colour noise, banding or hot pixels. 

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and neutral-

ise white and black - the icing on the cake for professional colour cor-

rection. 

Exposure: Here you again influence the shadows, highlights, contrast 

and brightness of the original images. Dynamic Brightness adjusts the 

brightness individually to the image content. What's new is that you 

can set an exposure value from -10EV to +10EV and use this value to 

fine-tune the exposure by -1EV to +1EV in addition. You can also 

change the soft contrast in the image. This reverses the brightness 

differences in the image on a large scale. 
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Structure: Fine-tune clarity and micro-details with lights, shadows 

and midtones. 

Colour: These colour settings are 

about luminosity in shadows and 

lights. Here you can also counteract 

unwanted chromatic aberrations.  

A lens curvature is calculated back-

wards on the selected colour channel. 

You have the choice between: "Dif-

fraction Green", "Diffraction Blue" and 

"Diffraction Red".  

In these colour settings, it is about lu-

minosity in shadows and lights. Here 

you can also counteract unwanted 

chromatic aberrations.  

The "colour effects" contain the fol-

lowing functions: pastel colours, 

bleach bypass and colour angle. Pas-

tel colours tend to be light colours, so 

amplification will brighten the image a 

bit. The colour angle rotates the image 

through the entire colour circle. 

Under "Colour Channels" you can 

change the brightness of the red, 

green or blue components. 

 

Palate: Adjust the saturation of individual colours. 

Distortion: Take a closer look. These mighty tools can straighten out 

the horizon, correct camera angles and lens errors. Use “Autofit” to 

automatically trim any awkward borders. 
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The reference grid can be adapted in the distance between the grids 

as well as in its transparency. This is how you will always have the 

maximum overview when you are correcting your settings. 

 

Lens correction: Corrects the edge light loss that occurs with some 

lenses. 

Peripheral light: Corrects the curvature of the lens. 

Horizon: Corrects the horizon by rotating the image. 

Vertical: Tilt the image left or right for vertical perspective correc-

tion. 

Horizontal: Tilt the image left or right for horizontal perspective cor-

rection. 

Zoom: Zooming the image avoids empty areas that may occur dur-

ing distortion correction. 

Trapezoid left/right: The vertical trapezoid correction pulls the im-

age either at the left or right edge of the image and corrects the per-

spective. 

Trapezoid top/bottom: Horizontal trapezoid equalisation draws the 

image either at the top or bottom of the image and corrects the per-

spective. 
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Stretch left/right: With this parameter you can stretch the image 

into the width, starting from the left or right edge of the image. 

Stretch top/bottom: With this parameter you can stretch the image 

upwards, starting from the top or bottom edge. 

Aspect: Change the aspect ratio of your image files. 

Shift L-R: Shift the image files to the left or right. 

Shift U-D: Shift the image data up or down. 

 

Categorie FX: 

This category contains some special effects, like a haze & fog correc-

tion, the rescue of highlights, sepia and film grain as well as different 

brightness gradients. 

New effects: 

- Reduce stray light 

- Polarising filter 

- Ageing (Reduce optical age) 

Pro Hint: 

When you take a landscape shot, shift the controller to Gradient top 

to a dark tone and create in that way a neutral thick (ND) – process 

filter. 

General:  

Activate the 360° panorama mode to optimise matching edges of im-

ages in a panorama series. Save your settings as a camera profile to 

save time in the future. This can be reset at any time. 

If you have conducted the settings in RAW mode, click on Apply. 

If you save your settings in the camera profile, you will save a lot of 

time for future photographs. The settings can be reversed at any time 
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Zoom and Brightness 

At the top right are the sliders for zoom and brightness of the picture 

display.  

Note: With the brightness setting of the picture display, you do not 

change the brightness of your picture, but only the display, for exam-

ple to be able to recognize the effect of picture noise in darker areas. 

 

Histogram 

The histogram is located below the sliders.  

RGB: Here the RGB values of the pixel are displayed below the mouse 

pointer. 

HSL: Displays the HSL values of the pixel below the mouse pointer. 

Note: HSL stands for Hue (colour angle), Saturation (colour satura-

tion) and Lightness (brightness). 
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19.   Batch Processing 

SHARPEN 4 professional’s batch processing allows automatic pro-

cessing of multiple bracketing series. The function can be found in the 

drop-down menu for Extras in the menu bar.  

First, choose the source folder where the individual images (HDR from 

one exposure) and/or the bracketing series are located. The files can 

also be mixed since the system will automatically recognise and sort 

the bracketing series vs single shots 

Note: Remember that looking through folders with several subfolders 

can require a lot of time. Therefore, selecting C:\ is not recommended. 

Source file: Here you define where the result images of the batch pro-

cessing are to be saved. Simply select the corresponding folder using 

the Select destination folder (. . .) button or enter the destination 

folder directly into the text field. 

Results: You can choose from nine formats for the storage format of 

the result images from batch processing. You can choose between 

.jpg, .tif and .png. JPG images are always saved uncompressed and 

lossless in the highest possible quality and TIF files. 

 

Processing settings 

In the processing settings, select the default setting for image gener-

ation. These are valid for all batch exposure series. 

- Image preparation: Allows you to change all RAW pro-

cessing and image orientation settings of the current batch 

processing.  

- Image sharpness: Select the default setting for the image 

sharpness from chapter 9.4. 

- Post-Processing: The preset default setting contains all pre-

sets from the post-processing area. 
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Note: On a Macintosh computer, this dialog opens before the batch 

window due to the system. 

Click on the arrow at the bottom left to reset the batch processing to 

the default values. 
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20.  Plug-in Installation 

SHARPEN 4 professional can also be used as a plug-in for Adobe® 

Photoshop. Newer versions of Photoshop are automatically detected 

by SHARPEN 4 professional during installation and the plug-ins are 

installed in the respective plug-in folder. Older versions of Photoshop 

might require manual installation. 

If you have purchased a download or lost your CD, you can add the 

Plug-Ins later from www.projects-software.de/plugins.  

 

20.1 Using Photoshop Plug-ins - Windows 

The following window will appear when installing SHARPEN 4 profes-

sional: 

 

 

Select the version of Photoshop where you would like to install the 

SHARPEN 4 professional plug-in. Click on Next and follow the in-

structions from the installation assistant. The plug-ins will then be au-

tomatically installed.  
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You can also carry out the installations of the Plug-ins at a later point 

in time. Please install Photoshop first then the projects plug-ins! 

After the installation of the Plug-ins please open Photoshop once 

more. 

 

 

Via Filter/Accelerated Vision/SHARPEN 4 professional the image im-

ported in Photoshop is opened in SHARPEN 4 professional.  

Click on SHARPEN 4 professional. The opened and edited image in 

Photoshop will now be opened in SHARPEN 4 professional. 

Now the program is in the Photoshop Filter-Plug-in mode. You can 

edit the image in SHARPEN 4 professional. Subsequently, you can 

send the finished image over the control Apply back into the Pho-

toshop-level. 
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With the control Cancel you close the Filter-Plug-in without sending 

the changes in the image back to the Photoshop level. The editing 

done in SHARPEN 4 professional will be discarded. 

 

The projects program will then automatically close, a mechanism that 

is made mandatory by Adobe Photoshop. 

 

20.2 Using Adobe Lightroom Plug-ins - Windows 

Start the installation program and verify that the component chosen 

is Lightroom Plugin. 

 

If you do not have a CD, download the Plug-in from www.projects-

software.de/plugins.  

Then open the Lightroom version. Start Lightroom and follow the di-

rections File → Plug-in manager to verify that the Plug-in is activated. 
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If this is not the case, then you can click on Add in the additional mod-

ule manager to then install the Lightroom Plug-in manually. 

 

Lightroom: SHARPEN 4 professional: Installed and executed. 

 

Highlight the exposure series in your Lightroom library. 

 

Click with the right mouse button directly onto the highlighted images 

and choose the entry Export → Export to SHARPEN 4 professional. 
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Or: Choose File → with the target export → Export to SHARPEN 4 

professional. 
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21.  Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

In the main menu in Information you will find an overview of all avail-

able keyboard shortcuts.  

 

Click on this item to open the overview: 

 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts. 
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General: 

  

Ctrl N   New project 

Ctrl Shift O    Upload single image 

Ctrl S    Save result image 

Ctrl D    Print result image 

Shift Z    Create restore point 

Ctrl T    Open timeline 

Ctrl F4  Leave program 

F4  Open RAW mode 

F7  Show post-processing view 

Ctrl P    Open settings 

Ctrl B    Open batch processing 

@  Show product homepage 

Shift F1  Open about window 

Ctrl E    Show exif information 

Ctrl H   Show/ hide histogram 

Ctrl F   Open/ close full screen 

 

 

Image Functions: 

  

Ctrl +  Zoom in 

Ctrl -  Zoom out 

Ctrl 0  Adjust image to view 

Ctrl 1  Zoom to 100% 

R   Real-time mode on/off 

L   Lock radar window (lock) 

 

 

RAW Developing: 

  



SHARPEN 4 professional – User manual 

127 

Ctrl +  Zoom in  

Ctrl -  Zoom out 

 

 

Progress Browser: 

  

Image upwards   A page back 

Image downwards   A page forward 

Pos1 key  To the beginning 

End key   To the end 

Cursor left   Last entry 

Cursor right   Next entry 

 

 

Selective Drawing: 

  

Ctrl +  Zoom in 

Ctrl -  Zoom out 

Ctrl 0  100% View/ switch adjustments 

A   Activate pencil  

Shift A    Activate pencil  with limit 

S  Activate rubber  

Shift S    Activate rubber with limit 

W  Activate soft focus brush  

E   Activate image mask creator 

D   Activate fill mode 

F   Activate brush fill mode 

R   Activate brush streak mode 

1  Reduce brush size 

2  Increase brush size 

3  Reduce opacity 

4  Increase opacity 
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5  Soften outline recognition 

6  Sharpen outline recognition 

7  Reduce blur 

8  Increase blur 

Ctrl Z   One step back 

M, Shift M    Mask display on/off 

 

 

Scratch/ Sensor Spot Removal: 

  

Ctrl +   Zoom in 

Ctrl -   Zoom out 

 

Cursor left, Shift Cursor left, Ctrl Cursor left  Shift active correction region left 

Cursor right, Shift Cursor right, Ctrl Cursor right Shift active correction region right 

Cursor upwards, Shift Cursor upwards, Ctrl   Shift active correction region up- 

Cursor upwards   wards 

Cursor downwards, Shift Cursor downwards, Shift active correction region 

Ctrl Cursor downwards  downwards 

Image upwards  Image upwards  Select previous correction region 

Image downwards Image downwards  Select next correction region 

C  C  Activate all correction regions 

N  N  Set new correction region 

Delete key Delete key  Delete correction region 

+ +  Enlarge active correction region 

- -  Minimise active correction region 

 

Image Cropping: 

Cursor left, Shift Cursor left, Ctrl Cursor left  Shift cropping region to the left 

Cursor right, Shift Cursor right, Ctrl Cursor  Shift cropping region to the right 

right  

Cursor upwards, Shift Curser upwards, Ctrl  Shift cropping region upwards 
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Cursor upwards 

Cursor downwards, Shift Cursor downwards,   Shift cropping region 

downwards 

Ctrl Cursor downwards  
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22. Integrated List of Supported RAW Formats 

In the main menu in Information, you will find an integrated list of 

supporting camera RAW-formats sorted by manufacturer.  

 

 

If you choose this menu item, a camera RAW-format window will 

open. 

 

In the top area of the window, you will find a selection of choices with 

which you will be able to filter the list for singular camera manufac-

turers. This way you will find your camera faster. 

To have constant access to the supporting camera RAW- formats via 

a separate window, you can use the function Open in browser (win-

dow bottom left), which will show the list in a standard browser. You 

will also be able to print the supporting RAW formats from there. 
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